
Instrukcja użytkownika P4S-341

Opis ogólny

P4S-341 jest przemysłowym programowalnym panelem I/O. Dołączając P4S-341 do urządzeń 
takich jak czujniki czy wyzwalacze możesz zbudować różnorakie systemy komunikacji sieciowej. 
Dla programowania P4S-341 udostępniamy developerski język programowania, zwany PHPoC. 
Język ten jest łatwy i kompatybilny z PHP będącym szeroko rozpowszechnionym językiem 
skryptowym.

 PHPoC jest zasadniczo kompatybilny z PHP, lecz języki te nie są tożsame ze względu na ※
ograniczenia  wynikające z właściwości systemu. Bardziej szczegółowych informacji szukaj 
PHPoC Language Reference oraz      PHPoC vs PHP.

Najważniejsze cechy
• Zapewniony Interpreter PHPoC 
• Zapewnione proste środowisko rozwojowe poprzez USB
• Udostępniony Ethernet 10/100Mbit 
• Dostępne 20 portów dwustanowych  i/o oraz 6 wejść analogowych 
• Dostępne 2 porty UART 
• Możliwość wykorzystania 4 timerów hardware-owych 
• Dostępne interfejsy I2C i SPI 
• Do dyspozycji debugger  PHPoC – narzędzie rozwojowe dla Windows
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Specyfikacja

Zasilanie

Wejście1 DC 5V (±0.5V)

Wejście 2 Wejście 2 DC 5V (±0.5V) - USB Device Port

Pobór prądu
Typowo - około 110mA
W trybie Power Down  - mniej niż 200uA

Wymiary 66.5mm x 63.8mm x 13mm

Ciężar około 29.8g

Interfejs

UART
2 X UART Ports(UART0 ~ 1),
Szybkość transmisji: 1,200 bps ~ 460,800 bps

Sieć Ethernet 10/100Mbps 

USB
USB Host - DM i DP
USB Device - dla PC

Cyfrowe I/O UIO0: pin #0 ~ #19, #30(LED), #31(LED)

Wejścia analogowe ADC_CH0 ~ 5, AREF, rozdzielczość 12-bit 

Timer sprzętowy (HT) HT0 ~ 3, wyjście toggle/pulse/pwm i tryb capture

SPI NSS, SCK, MISO, MOSI

I2C SCL, SDA

Bateria wewnętrzna 3.05.2016

Firmware Interpreter PHPoC 

Temperatura
Składowanie

/Robocza
-20  ~ 60℃ ℃

Środowisko Zgodność z RoHS 

Software Debugger PHPoC 
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Wymiary

P4S-341 R1 Wymiary (mm)

 Wymiary mogą się różnić zależnie od sposobu pomiaru.※
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Rozmieszczenie elementów

1. LED

Na płytce P4S-341 występuje 6 diod LED.

LED Funkcjonowanie

PWR / 3.3V / PWR5 Zasilanie > ON

STS
Uruchomione PHP > powtarzające się miganie co 1 sekundę
Nieuruchomione PHP > krótkie mignięcie od czasu do czasu

UIO30 LED na płytce: połączony z 30-tym pinem UIO0

UIO31 LED na płytce: połączony z 31-tym pinem UIO0

 Sygnały PWR, STS, UIO30 oraz UIO31 znajdują się również na odwrotnej stronie.※

2. Ethernet

P4S-341 udostępnia złącze Ethernet 10/100Mbps .
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3. Przycisk funkcyjny (Func)

Przycisk funkcyjny jest używany do zmiany trybu pracy urzadzenia.

4. Port USB dla podłączenia do PC

Port USB służy do połączenia z PC. Możesz uzyskać dostęp do P4S-341 poprzez narzędzie 
uruchomieniowe podłączając kabelek USB do tego portu. Dzięki temu portowi uzyskujesz również 
zasilanie DC 5V . Należy jednakże mieć świadomość, że P4S-341 może nie pracować prawidłowo 
w przypadku takiego zasilania wskutek niewystarczającej wydajności prądowej.

5. Gniazdo zasilania 

• Wejście DC 5V 
To gniazdo jest głównym portem wejściowym dla zasilania. Specyfikacja jest następująca:

• Port USB  (Micro USB)
Ten port może być portem wspomagającym zasilanie płytki.

6. Przycisk Reset (RESET)

Przycisk ten używany jest do resetowania modułu.

7. Port konsoli 

Ten port jest portem dla zarządzania modułem.

Opis Wartość

Poziom sygnałów 3.3V

Konfiguracja 115,200bps / 8 Data bit / 1 Stop bit / No parity

Przypisanie Pin-ów #1 - 3.3V, #2 - RX, #3 - TX, #4 - GND
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8. JP1
Oznaczenie Opis Oznaczenie Opis

3.3V Wyjście 3.3V PWR5 Zasilanie wyjścia (5V±0.5V)

GND Masa AREF ADC port wejścia referencyjnego 

AD0 ADC kanał 0 AD3 ADC kanał 3

AD1 ADC kanał 1 AD4 ADC kanał 4

AD2 ADC kanał 2 AD5 ADC kanał 5

GND Masa GND Masa

HT0 Timer sprzętowy 0 HT2 Timer sprzętowy 2

HT1 Timer sprzętowy 1 HT3 Timer sprzętowy 3

NSS/0 SPI - NSS / UIO0 #0 12 UART #1 RTS / UIO0 #12

SCK/1 SPI - SCK / UIO0 #1 13 UART #1 CTS / UIO0 #13

MISO/2 SPI - MISO / UIO0 #2 14 UIO0 #14

MOSI/3 SPI - MOSI / UIO0 #3 15 UIO0 #15

U0TX/4 UART #0 TX / UIO0 #4 16 UIO0 #16

U0RX/5 UART #0 RX / UIO0 #5 17 UIO0 #17

SCL/6 I2C - SCL / UIO0 #6 18 UIO0 #18

SDA/7 I2C - SDA / UIO0 #7 19 UIO0 #19

8 UART#0 RTS / UIO0 #8 DM D- (USB Host)

9 UART #0 CTS / UIO0 #9 DP D+ (USB Host)

U1TX/10 UART #1 TX/ UIO0 #10 STX Zarezerwowane

U1RX/11 UART #1 RX/ UIO0 #11 SRX Zarezerwowane

GND Masa SR0 Zarezerwowane

PWR5 Zasilanie wyjścia (5V±0.5V) 3.3V Wyjście 3.3V 

9. JP4(VDDA-AREF)

Jeżeli jumper jest obecny, napięcie 3.3V jest podawane na wejście referencyjne przetwornika 
analogowego (AREF).

10. Bateria wewnętrzna

Bateria wewnętrzna służy do podtrzymywania zapamiętanych logów oraz  funkcjonowania RTC. 
Specyfikacja baterii jest następująca:

Parametr Wartość

Pojemność 40mAh

Napięcie znamionowe 3V DC
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Interfejs komunikacyjny (JP1)

Wejście analogowe: ADC
P4S-341 udostępnia 6 kanałów wejściowych ADC . Dla skorzystania z tego wejścia wymagane jest
podłączenie napięcia referencyjnego do pinu AREF. Jeżeli podłączysz jumper VDDA-AREF, 
dołączysz napięcie 3.3V do pinu AREF.
Specyfikacja portów ADC jest następująca:

Parametr Wartość

Rozdzielczość 12 bitów (0 ~ 4095)

Typ wejścia DC Voltage (Max. 3.3V)

Liczba kanałów 6 kanałów

Oznaczenie pinów interfejsu AREF, AD0 ~ 5

Timer sprzętowy: HT

P4S-341 udostępnia 4 timery sprzętowe oznaczane jako  HT.
Specyfikacja HT jest następująca:

Parametr Wartość

Tryb Tryb wyjscia (toggle, pulse, PWM), Tryb Capture

Jednostka ms(milisekunda) lub us(mikrosekunda)

Liczba kanałów 4 kanały

Oznaczenie pinów interfejsu HT0 ~ 3

Wejścia/wyjścia cyfrowe (dwustanowe): UIO

P4S-341 udostępnia 24 porty I/O włączając 20 uniwersalnych portów I/O (numerowanych 0 do 19),
port USB Host (DM i DP) oraz 2 porty LED (numerowane 30 i 31). Dwa LED-y na panelu są 
przypisane do  numerów 30 oraz 31. Piny numerowane 0 do 19 mogą być dostępne jako 
dwustanowe wejście lub wyjście lecz te piny, które  są przydzielane do interfejsów szeregowych 
(numerowane 0 do 13) nie mogą być używane jako cyfrowe/dwustanowe wejście lub wyjście gdy 
są one używane przez komunikację szeregową (UART, SPI i I2C).

• Parametry elektryczne cyfrowych I/O

Parametr Opis Min.[V] Max.[V] Prąd

VIH Poziom WYSOKI wejścia 2.31 - -

VIL Poziom NISKI wejścia 0 0.99 -

VOH Poziom WYSOKI wyjścia 2.4 - +8mA

VOL Poziom NISKI wyjścia 0 0.4 +8mA
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• Uszeregowanie pinów dla cyfrowych I/O

' /mmap/uio0 '

Port Szeregowy UART
P4S-341 udostępnia 2 porty UART.
Ich specyfikacja jest następująca:

Parametr Wartość

Liczba portów 2

Oznaczenie pinów 
interfejsu

UART0: Wymagane (U0TX/4, U0RX/5, GND), Opcjonalne(U0RTS/8, U0CTS/9)
UART1: Wymagane (U1TX/10, U1RX/11, GND), Opcj. (U1RTS/12, U1CTS/13)

Poziom sygnału 3.3V

Szybkość transmisji 1,200 ~ 460,800 [bps]

Parzystość NONE / EVEN / ODD / MARK / SPACE

Bity danych 8 / 7 (parzystość jest wymagana w trybie transmisji 7-bitowej)

Bity stopu 1 / 2

Kontrola przepływu NONE, RTS/CTS

Port Szeregowy SPI
P4S-341 udostępnia interfejs SPI .
Specyfikacja SPI jest następująca:

Parametr Wartość

Liczba portów 1

Poziom sygnału 3.3V

Oznaczenie pinów interfejsu NSS/0, SCLK/1, MOSI/2, MISO/3

Tryb SPI tryb 0 ~ 3

Kolejność bitów LSB > MSB or MSB > LSB

Jednostka transmisyjna 8bit or 16bit

Szybkość zegara podstawowego 42㎒

Częstotliwość 2 / 4 / 8 / 16 / 32 / 64 / 128 / 256
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Port szergowy: I2C
P4S-341 udostępnia interfejs I2C.
Jego specyfikacja jest następująca :

Parametr Wartość

Liczba portów 1

Poziom  sygnału 3.3V

Oznaczenie pinów interfejsu SCL, SDA

Szybkość danych Tryb standardowy(100Kbps) lub tryb szybki (400Kbps)

Typ adresowania 7 bitów
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Środowisko uruchomieniowe
P4S-342 udostępnia środowisko uruchomieniowe poprzez USB. Do zaprogramowania P4S-341 
lub debuggowania kodów źródłowych PHPoC  wymagany jest Debugger PHPoC, będący 
oprogramowaniem narzędziowym.

Debugger PHPoC 

Wprowadzenie do programu

PHPoC Debugger jest oprogramowaniem działającym w środowisku Windows. Możesz załadować 
pliki do P4S-341 dzięki temu oprogramowaniu korzystając z portu USB.

Cechy debuggera PHPoC są następujące:

• Ładowanie plików z lokalnego PC do P4S-341
• Zapisywanie plików z P4S-341 na lokalnym PC
• Edycja plików zapisanych w P4S-341
• Debugowanie skryptów PHPoC 
• Monitorowanie zasobów  P4S-341 
• Konfiguracja parametrów P4S-341
• Upgrade Firmware  P4S-341

Program UI (interfejs użytkownika)
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1. Menu

MENU Pod-MENU OPIS

File

Open a poc file Otwiera plik w formacie poc

Save selected file(s) Zapisuje wybrane z listy pliki na lokalnym PC

Save a poc file Zapisuje wszystkie pliki na lokalnym PC (.poc)

Edit

Undo Cofnięcie ostatniej operacji

Redo Ponowienie ostatniej niewykonanej operacji 

Cut Wycięcie zaznaczonego tekstu i skopiowanie do schowka

Copy Skopiowanie zaznaczonego tekstu do schowka

Paste Wklejanie tekstu ze schowka

Select all Zaznaczenie całego tekstu

Find Znajdowanie tekstu

Find Next Znajdowanie tekstu poniżej

Find Previous Znajdowanie tekstu powyżej

Change Zamiana zaznaczonego tekstu z wpisanym w formularz 

Preferences Preferencje programu 

Function

Product/Firmware information Informacja o produkcie/Firmware

Network information Informacje o bieżącej sieci

View PHP error log Podgląd logu błędów PHP

View firmware error log Podgląd logu błędów firmware

Upgrade firmware Aktualizacja firmware

Reboot a product Restart urządzenia

Firmware debug mode Zezwolenie / Brak zezwolenia na tryb debuggingu Firmware

PHP debug mode Zezwolenie / Brak zezwolenia na tryb debuggingu PHP

Font Zmiana czcionki

Language Zmiana języka

PHPoC Debugger information Informacja o programie

• Preferencje

Menu Pod-menu Opis

View

View margin Pokaż/ukryj margines 

View line number Pokaż/ukryj numer linii marginesu

Vew current line Pokaż / Ukryj wyróżnienie bieżącej linii

Auto scroll Umożliwienie/zakaz autoscrollowania

Line ratio Ustaw odstęp linii: 100, 120, 150, 200, 300

Tab size Ustaw wielkość tabulatora: 1, 2, 4, 8, 16

Action of file add

Internal editor Użyj edytora wewnętrznego

External editor Użyj edytora zewnętrznego

Ask Zawsze pokazuj opcję wyboru

Backup path Ścieżka dla plików backup

Initialisation Enter initialisation mode Ustaw wyrób dla trybu inicjalizacji
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2. Port COM 
Miejsce wyboru wirtualnego portu COM (wejście USB).

3. Przyciski

Przycisk Opis

Podłącz do wyrobu PHPoC

Odłącz od wyrobu PHPoC

Skonfiguruj zmienne środowiskowe wyrobu PHPoC

Prześlij pliki [File list] do urządzenia

Zatrzymaj wykonywania skryptu PHPoC

Uruchom/wstrzymaj skrypt PHPoC

Uruchom linia po linii

Uruchom procedura po procedurze

4. Lista plików
Lista plików PHPoC zapisanych w urządzeniu lub do załadowania.

Ikonka Opis

Pliki zsynchronizowane

Pliki na wyrobie PHPoC przed synchronizacją

Pliki na lokalnym PC przed synchronizacją

Zsynchronizowane pliki na lokalnym PC dla edytorów zewnętrznych

Następujące pozycje menu ukażą się w polu plików po kliknięciu prawego przycisku myszy.

Menu Opis

New Stworzenie nowego pliku php

Change filename Zmiana nazwy

Add Dodanie plików z lokalnego PC

Delete Kasuj plik na liście

2016-11-15 Sollae Systems strona: 12/33



Instrukcja użytkownika P4S-341

5. Edytor
Pokazywanie i edycja zawartości wybranego pliku na liście plików.
Następujące pozycje menu ukażą się w polu edycji po kliknięciu prawego przycisku myszy.

Menu Opis Skrót

Toggle breakpoint Ustaw/kasuj pułapkę w bieżącej linii F9

Remove All breakpoints Kasuj wszystkie pułapki w bieżącym pliku Shift +F9

Step info Uruchom linia po linii F11

Step over Uruchom procedurę po procedurze F10

Run to the current line Uruchom i zapauzuj przed wykonaniem bieżącej linii -

Cut Wytnij wybrane kody i skopiuj do schowka Ctrl+X

Copy Skopiuj wybrane kody do schowka Ctrl+C

Paste Wklej kody ze schowka Ctrl+V

Select all Wybierz wszystkie kody Ctrl+A

6. Wielkość pamięci Flash 
Ukazuje aktualnie dostępną lub zajętą w wyrobie PHPoC.

7. Wyjście / FW Log
To okno służy do wyświetlania standardowych komunikatów wyjściowych i F/W log.
Następujące pozycje menu ukażą się w tym polu po kliknięciu prawego przycisku myszy.

Menu Opis

Delete all logs Wyczyść bufor ekranu

Copy Kopiuj wybrany log do schowka

Auto scroll Zaznacz/odznacz automatyczne scrollowanie

8. Śledzenie / Zasoby

To okno służy do sprawdzania informacji zmiennych bieżących oraz zasobach systemowych.
Następujące pozycje menu ukażą się w polu zmiennych po kliknięciu prawego przycisku myszy.

Menu Opis

Add Dodaj zmienną

Modify Modyfikuj nazwę wybranej zmiennej

Delete Kasuj wybrane zmienne

Delete all Kasuj wszystkie zmienne

Detail Wyświetlenie nowego okna ze szczegółowymi informacjami

Refresh Odświeżanie wartości zmiennych
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Stworzenie środowiska rozwojowego

Lokalny komputer PC

Do załadowania plików php do P4S-341 wymagany jest komputer PC z systemem MS Windows 
podczas gdy tworzenie i modyfikacja samych plików php mogą być dokonywane w innych 
systemach operacyjnych.

Podłączanie P4S-34

Podłącz P4S-341 do PC za pomocą kabelka USB.

Uruchamianie debuggera PHPoC 
Uruchom debuggera PHPoC na komputerze PC.

 Ten dokument definiuje „Upload” jako przesłanie plików z PC do P4S-341.※
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Podłączanie wyrobu

Podłączanie wyrobu
Podłącz P4S-341 do swojego PC z wykorzystaniem kabelka USB. Driver urządzenia zostanie w 
tym momencie automatycznie zainstalowany. Gdy automatyczna instalacja się nie powiedzie, 
ściągnij i zainstaluj driver ze strony ST Micro lub z poniższego linku.

 ※STM32 USB Virtual Com Port Driver Download page

 Driver nie może zostać zainstalowany automatycznie. W takim przypadku, prosimy skorzystać ※
ze wskazówek zawartych w spakowanym (zip) w pliku readme.txt.

Gotowość komunikacji

1. Uruchom Debugger PHPoC 
2. Wskaż używane port COM PORT i wciśnij przycisk łączenia (             ) .
3. Jeżeli USB zostało podłączone, przycisk łączenia pozostanie nieaktywny zaś 

aktywowany zostanie przycisk rozłączania (            ) 
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Podłączanie wyrobu

Obsługa PHPoC 

PHPoC przeszukuje plik "init.php" zaraz po jego restarcie. Jeśli nie ma żadnego pliku "init.php", 
żaden kod PHPoC nie zostanie zaimplementowany. Tak więc musisz stworzyć lub załadować plik 
"init.php" do systemu plików PHPoC . Można napisać skrypt na  "init.php" jak również uruchomić 
inne pliki php wykorzystując polecenia systemowe. Skrypt "init.php" jest zaimplementowany tylko 
jeden raz lecz pliki załadowane przez polecenia systemowe mogą być wykonywane wielokrotnie.

 Skorzystaj z „※ PHPoC System Function” dla uzyskania szczegółowych informacji o funkcjach 
systemowych.

• Uruchamianie skryptu w "init.php"

• Uruchamianie innego pliku php w "init.php"
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• Arkusz uruchamiania skryptu

 "init.php" jest początkiem wszystkich skryptów. Oznacza to, że każdy plik php jest bezpośrednio ※
lub pośrednio załadowaniy w "init.php" w celu uruchomienia.

Pliki fabryczne

P4S-341 jest dostarczany z następującymi załadowanymi plikami.

Nazwa pliku Opis

/lib/sd_340.php Podstawowa biblioteka P4S-341/342

/lib/sn_tcp_ws.php Biblioteka WebSocket

2016-11-15 Sollae Systems strona: 17/33



Instrukcja użytkownika P4S-341

Podłączanie produktu
• Kliknij na „file list” prawym przyciskiem myszy  i wybierz menu [New] .

• Wpisz "init" w okienku nazwy pliku.
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• Wybierz plik init.php na wykazie plików.

• Wprowadź następujące linie poleceń do edytora.

• Kliknij przycisk ładowania  (              )

• Gdy PHPoC zakończy ładowanie plików do urządzenia, ikona zmieni się. (        →         )

Wykonywanie skryptów

PHPoC automatycznie uruchamia skrypt po resecie lub załadowaniu system plików.
Wynik można znaleźć w oknie Output debuggera PHPoC .

 Jeżeli opcja debuggera PHPoC [PHP debug mode] jest aktywna, PHPoC nie wykonuje skryptu ※
automatycznie. Możesz ręcznie uruchomić skrypt klikając przycisk Run. (              )
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Zapisywanie plików na PC

Zapisywanie pliku na PC

1. Wybierz pliki z listy plików

2. Kliknij [File] > [Save selected file(s)] w okienku menu 

3. Wybierz ścieżkę i kliknij przycisk [OK] .
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Zapisywanie zintegrowanego pliku (.poc)

Jeżeli chcesz zachować wszystkie pliki występujące na wykazie jako pojedyncze pliki, użyj menu 
[Save a poc file] .

".poc" jest rozszerzeniem nazwy pliku. Wprowadź nazwę pliku i kliknij przycisk [Save].
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Ładowanie plików do Produktu
Pliki php na lokalnym PC mogą być ładowane do P4S-341.

Jak dodawać pliki do listy plików

• „Przeciągnij i upuść”

Wybierz i przeciągnij pliki w oknie explorera Windows a następnie przeciągnij i upuść je w polu 
[File list].

• Menu Add 

Jeżeli klikniesz [Add] po kliknięciu prawym przyciskiem myszy w polu „File list”, otworzy się okno 
wyboru plików. Wybrane pliki będą dodane do wykazu „File list”.

 Plik zintegrowany (.poc) powinien być dodawany wyłącznie przez menu [File]>[Open a poc file] .※
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Ładowanie plików

Pliki w wykazie „file list” będą ładowane do P4S-341 po kliknięciu przycisku ładowania (         ) .
Po zakończeniu ładowania, zarówno pliki w polu „File list” jak i w P4S-341 są zsynchronizowane a 
ikony są zmienione na  (     ).
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Ładowanie plików do produktu
Pakiet pomocniczy PHPoC (PSP) zawiera biblioteki i przykładowe kody. Ten pakiet ma na celu 
pomoc w implementacji PHPoC. Przed uruchomieniem testu, ściągnij go na swój lokalny PC.

 Link do ściągnięcia PSP : ※ Download Page

Wybór przykładu

PSP zawiera wiele przykładów z wykorzystaniem różnych czujników. Wybierz interesujący 
przykład i załaduj pliki do PHPoC. Są trzy kategorie przykładowych skryptów:

• Przykłady zadań podstawowych (basic task examples)

Te przykłady wymagają załadowania zarówno "init.php" jak i  "task0.php".

• Przykłady zadań sieciowych  (web task examples)

Te przykłady wymagają załadowania "index.php" oraz ustawienia zestawu plików 
obrazowych (jeśli występują).

• Przykłady zadań będących kombinacją powyższych (basic and web task)

Te przykłady wymagają załadowania "init.php", "task0.php" oraz "index.php" zawierające 
zestaw plików obrazowych (jeśli występują).
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Wykorzystanie przykładów 

• Znajdź i załaduj przykład 00.hello w folderze p4s/01.php_task .

• Możesz znaleźć informację wynikową zaraz po załadowaniu plików.
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Konfiguracja parametrów

Wszystkie parametry włączając adres IP mogą być konfigurowane poprzez debugger PHPoC .

1. Podłącz produkt PHPoC do PC.

2. Uruchom debugger PHPoC i kliknij przycisk  łączenia (          ) po wybraniu prawidłowego 
portu COM.

3. Następnie kliknij przycisk konfiguracji  (          ).

 Czasami możesz zauważyć nieaktywny przycisk konfiguracji. W takim przypadku kliknij ※
przycisk stop (         ) przed konfiguracją.

4. Skonfiguruj parametry
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Parametry systemowe

Tab Kategoria Parametr

Sieć

IPv4

IP address

Subnet mask

Gateway IP address

DNS server IP address

IP address type - Use static IP address

IP address type - Obtain an IP automatically (DHCP)

IP address type - Obtain DNS server address automatically

IPv6

IPv6 - Enable / Disable IPv6

IP address type - Obtain an IP automatically

IP address type - Use static IP address

EUI - MAC Address / Random

IPv6 address and Prefix

Gateway IPv6 address

Uzyskaj adres serwera DNS automatiycznie

Adres serwera DNS 

Przyciski

Time Ustaw czas RTC 

Password Hasło (ID: Admin)

Certificate

Zapisz certyfikat self-signed

Wpisz certyfikat signed uzyskany od jednostki certyfikującej

Odczytaj certyfikat z urządzenia

 Uwaga: PHPoC nie wspiera odzyskania gdy zapomnisz swoje hasło . Możesz przywrócić ※
P4S-341 do ustawień fabrycznych z wykorzystaniem "level 2 initialization" lecz wszystkie twoje 
ustawienia, pliki i hasło zostaną skasowane.
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Inicjalizacja

Poziom 1 (Level 1)

Gdy wdrażasz inicjalizację poziomu 1 (level 1 initialization), zarówno parametry systemowe jak i 
parametry użytkownika włączając zapamiętany certyfikat są inicjowane do poziomu fabrycznego. 
Jednakże hasło i system plików pozostają niezmienione.

• Procedura inicjalizacji poziomu 1 

Krok Działanie Stan produktu STS LED

1 Wciśnij krótko przycisk funkcyjny (mniej niż 1 sekunda) Tryb ustawiania przycisku Świeci

2 Przytrzymaj wciśnięty przycisk funkcyjny powyżej 5 sekund
Przygotowanie do 
inicjalizacji

Miga 
szybko

3 Sprawdź, czy dioda STS LED jest zgaszona Inicjalizacja gotowa Zgaszona

4
Zwolnij przycisk funkcyjny gdy tylko dioda STS zgaśnie.
(  Jeśli nie zwolnisz przycisku w ciągu 2 sekund, ※
powrócisz do kroku 3 jak wyżej)

Inicjalizacja w toku Świeci

5 Automatyczny restart Stan początkowy Zgaszona

Poziom 2

Gdy wdrażasz inicjalizację poziomu 2, wszystkie parametry włączając hasło użytkownika oraz 
system plików są przywracane do stanu fabrycznego.

 Inicjalizację poziomu 2 należy przeprowadzać ostrożnie . Zauważ że przed jej dokonaniem ※
wskazane byłoby zgranie swoich plików na lokalny PC, gdyż zostaną one skasowane .

• Procedura inicjalizacji poziomu 2 

Krok Działanie Stan produktu STS LED

1
Ustaw Set PHPoC w tryb inicjalizacji
(Użyj menu [Edit]>[Preferences] w debuggerze PHPoC)

Wchodzi w tryb Inicjalizacji 
po restarcie

Miga 
szybko

2
Trzymaj wciśnięty przycisk funkcyjny przez ponad 10 
sekund

Przygotowanie inicjalizacji
Miga 
bardzo 
szybko

3 Sprawdź diodę STS LED po 10 sekundach Inicjalizacja gotowa Zgaszona

4
Zwolnij przycisk funkcyjny zaraz po zgaszeniu diody STS .
(  Jeśli nie zwolnisz przycisku w ciągu 2 sekund, stan ※
powróci do kroku 3 jak wyżej)

Inicjalizacja w toku Świeci

5 Automatyczny restart Stan początkowy Zgaszona
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Interfejs Web 
PHPoC posiada wbudowany webserwer dla korzystania z interfejsu web. Po otrzymaniu żądania 
HTTP , wykonuje się skrypt php żądanego pliku (jeśli istnieje) oraz odpowiada klientowi. 
Webserwer jest niezależny od głównego skryptu PHPoC. Używany jest TCP 80 i możesz użyć tego
interfejsu poprzez Internet Explorer, Chrome lub inną przeglądarkę internetową.

Jak używać interfejsu web

Aby użyć interfejsu web , należy zadbać, aby plik "index.php" znajdował się w systemie plików 
P4S-341. Połączenie ze stroną jest wtedy realizowane przez wprowadzenie adresu IP urządzenia 
po podłączeniu go do sieci.

Jeżeli nazwą pliku nie jest "index.php", po prostu podaj nazwę pliku po adresie IP i znaku 
ukośnika.
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Upgrade oprogramowania firmware

Ściągnij plik Firmware 

Sprawdź i ściągnij plik firmware ze strony PHPoC na lokalny PC.

Upgrade firmware

1. Podłącz port setup P4S-341 do lokalnego PC kabelkiem USB.

2. Uruchom debugger PHPoC i kliknij przycisk łączenia (         ) po wyborze portu COM .

3. Wybierz [Upgrade Firmware]  w menu [Function] .

4. Kliknij przycisk [Open] aby wybrać plik firmware.

5. Kliknij przycisk [Send].

6. Upgrading Firmware został zakończony.
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Używanie zewnętrznego edytora
W sytuacji, gdy nie chcesz używać wbudowanego edytora debuggera PHPoC lecz edytora 
zewnętrznego, po prostu ustaw opcję [External editor] na pozycji  [Action of file add] w okienku 
preferencji.

Gdy ładujesz pliki php z wykorzystaniem tej opcji, zablokowane ikonki jak niżej będą pokazane 
przy synchronizowanych plikach. Pliki z tymi ikonkami nie mogą być modyfikowane przez 
wbudowany edytor debuggera PHPoC lecz tylko przez edytor zewnętrzny.
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Tryb debugowania  PHP
PHPoC udostępnia funkcję debuggingu run-time. Przyciski dla debuggingu są aktywne gdy 
sprawdzasz opcję trybu debuggingu w programie PHPoC. W tym trybie, możesz ustawić pułapki 
lub sprawdzić wartości zmiennych przy każdej linii kodu.

Gdy wybrany jest tryb debuggingu PHP, ukazuje się biała strzałka po lewej stronie bieżącej linii 
kodu. W tym trybie dostępne są  wszystkie przyciski debuggingu.
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Wyjście z trybu zapętlonego restartu.
PHPoC zasadniczo uruchamia skrypty po restarcie. Dlatego możliwe jest, że P4S-341 nie może 
samoczynnie wyjść z trybu zapętlonego restartu, kiedy skrypt zawiera polecenie systemowe 
"reboot". Aby rozwiązać ten problem, wymagane jest zatrzymanie uruchomionego skryptu.
Należy podjąć następujące kroki.

1. Wejście w tryb ISP 
Uruchomić P4S-341 aby wejść w tryb ISP przez włączenie zasilania przy wciśniętym 
przycisku FUNC. W trybie ISP , masz dostęp do PHPoC poprzez debugger PHPoC bez 
uruchomionego skryptu.

2. Podłącz do PHPoC
Podłącz PC do PHPoC poprzez kabelek USB i podłącz do portu poprzez debugger PHPoC.
Ukaże się okno komunikatu powiązane z trybem ISP .

3. Restart PHPoC
Restart PHPoC wykorzystując menu "Reboot a product" w debuggerze PHPoC. Po 
zrestartowaniu, PHPoC zatrzyma uruchomiony skrypt nawet jeśli nie jest on w trybie ISP.

4. Popraw kod źródłowy
Popraw kod źródłowy aby uniemożliwić permanentny stan restartu.

Informacje o urządzeniu

Moduł Ilość kanałów Ścieżka Uwagi

UART 2 /mmap/uart0~1 -

NET 1 /mmap/net0 -

TCP 5 /mmap/tcp0~4 -

UDP 5 /mmap/udp0~4 -

Digital I/O 1 /mmap/uio0 pin #0 ~ #19, #30, #31

ADC 2 /mmap/adc0~1 -

ST 8 /mmap/st0~7 -

HT 4 /mmap/ht0~3 -

SPI 1 /mmap/spi0 -

I2C 1 /mmap/i2c0 -

RTC 1 /mmap/rtc0 -

UM 4 /mmap/um0~3 -

NM 1 /mmap/nm0 -

 Polecamy skorzystać z ※ PHPoC Device Programming Guide for p40 w celu uzyskania 
szczegółowych informacji o wymienionych modułach.
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